Larry's FCP Newsletter
Issue 5 -- May, 2004
Editor: Larry Jordan

Welcome to the fifth edition of my Final Cut Pro newsletter!
I am delighted by your continued interest and grateful for your
comments and suggestions. Please feel free to contribute ideas, requests
or clarifications.
The goal of this newsletter is to provide information helpful to the
professional user of Final Cut Pro. This will publish monthly, around the
middle of each month. Past issues are not archived, but last month's
issue is included as a PDF file at the end of the current issue. Unless
otherwise noted, all references are to Final Cut Pro version 4.x, and
should not be assumed to work under any other version.
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What's new this month on larryjordan.biz?
●
●
●
●
●
●
●
●

Article: Color-Correcting using the Limit Effect
Larry's Teaching Schedule -- June is VERY busy!
New Support options -- email and phone support now available!
Article: Creating a telephone audio effect
Article: Improve your transitions with gradient wipes
Tip: A faster way to create Filter Favorites
Article: Color-balancing using Match Hue
Article: Improve exteriors using gradients & composite mode

Go to top.

Editorial: Should You Upgrade to FCP HD?
This is not an easy question to answer. But here are some guidelines:
1. Once you upgrade and open a project in FCP HD, it is no longer
possible for it to be opened in earlier versions of FCP. For this
reason, ALWAYS make a backup copy of your projects, "just in
case."
2. Never upgrade in the middle of a project, unless you are dead in
the water and upgrading is your only hope. Always finish a project,
then upgrade.
3. If you are using DV footage only (i.e. Mini-DV, DVCAM, or DVCPRO25) the upgrade looks pretty good.
4. If you are using a CineWave card, you'll need to upgrade to the
latest version of CineWave (4.6) which shipped last week.
5. If you are using a Kona or Black Magic capture card, it's probably
OK to upgrade, according to the vendors -- however, be sure to
read point 6 below.
6. If you are using Compressor to compress SD footage, there are
reports that Compressor 1.2 does not handle SD compression well.
In which case, hold off upgrading for a bit longer, until this issue
gets resolved.
7. From my personal experience, FCP HD works fine on my G-5 and
I've had no problems. I like no longer worrying about the bugs
they fixed. However, I also don't own a CineWave card, and I
rarely edit SD or HD footage in my project studio.
I recently spoke, via email, with Clark Simpson, Manager AJA Tech
Support, about this issue. He wrote:
We have updated most FCP systems to 4.5 with no problem.
[However, we did get] several calls about problems. Most, if
not all, were fixed by uninstalling FCP 4.0, reinstalling FCP
4.0, then using Software Update to get back up to FCP 4.5.
[Larry again] My recommendation? If you are on a time-critical project,
or don't have time to mess with software glitches, don't upgrade. Wait a
while longer. If you have time to "get things tweaked," and you are
principally using DV video, the upgrade looks OK. There are still some
bugs in 4.5 that will require a point release. If you are editing SD video
and don't plan to move to HD, hold off a while longer.

Also, to prevent premature upgrading I suggest you turn OFF Software
Update's automatic checking for new software. This way, you won't be
tempted to upgrade the instant a new version is released.
Remember, your job is to edit, not field-test software.
Go to top.

Technique: Using Ganging to Compare Two Movies
I was recently doing some on-lining (converting a Final Cut project from
low-resolution video to a high-resolution master) when I discovered a
really neat trick that I want to share with you.
Here's the challenge: I've noticed, when using Media Manager to convert
a project from off-line quality to on-line quality, that the clips in the online version often drift by a few frames from the clips in the off-line
version. Also, the audio will sometimes drift out of sync with the video.
In a 30-minute documentary, consisting of literally hundreds of edits, I
needed a fast way to compare the off-line version with the on-line
version.
Here's a fast way to make it picture-perfect.

1) Before running Media Manager, create a reference movie of your offline edit. Open the sequence you want to on-line and go to File ->
Export -> Quicktime movie.

2) The export dialog box will open.

3) If you are on-lining on the same system you off-lined, UNcheck "Make
Movie Self-Contained." Otherwise, leave this checked.
4) Give your off-line reference movie a name and save your movie.
5) Create your on-line version (see the article: Tips to Improve Your Onlining.). Capture all media. Relink everything in your new on-line
sequence.
6) Open your off-line reference movie into the browser of your new online project
7) Open the off-line movie into the Viewer.

8) Position the playhead of the Timeline, which contains the on-line
version of your movie, on a frame of video who's position can be
precisely determined, for example, the last frame of your slate.

9) Position the playhead of the Viewer, which contains the off-line
version of your movie, to the exact same frame of video.

9) Select "Gang" from the middle pop-up menu in the Viewer.
10) Select the Timeline and press the down arrow key. Notice that your
Timeline moves to the next edit AND the Viewer follows EXACTLY in
sync. This makes it very easy to quickly step through every shot in your
on-line and make sure it matches the off-line version exactly.
I've used this technique twice now and it works flawlessly at spotting
shifted scenes.

Final Cut Pro Training
If you are looking for additional training on Final Cut Pro (any version),
please call me at (818) 879-5105 or send me an email
(larry@larryjordan.biz).
I provide a full range of training from a couple hours of individual skills
polishing all the way to full, hands-on intensive, multi-day courses.

Here's a list of some of the companies that have used my services.
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Technique: Using the Match Frame function
Match Frame is a technique that allows you to put your playhead on a
shot in the Timeline and find that exact same frame from the original
shot in the Browser.
For instance, Match Frame is an excellent tool to use to add sync audio
to a clip that you edited to the Timeline as video only.
Best of all, it's easy to use. (The screen shots used in these next two
techniques are courtesy of the Goucher College Theater video production
of The Bacchae, by Paul Jordan.)

1. Put your playhead in the clip in the Timeline to which you want to find
the Match Frame. Placement of the Playhead is important, because
whichever frame is displayed in the Canvas will be the frame that is
matched and displayed in the Viewer.

2. Type the letter "f," or select View -> Match Frame -> Master clip.

3. The original clip from the Browser will be automatically loaded into the
Viewer and the playhead will be positioned on exactly the same frame
that the playhead is displaying in the Canvas.
From here, you can edit it back into the Timeline as you would any other
clip.
Sometimes, though, you may want to find the original clip in the
Browser. For instance, you want to use a different clip from the same
longer shot.

4. In this case, put your Timeline playhead inside the clip you want to
find and type, "Shift-F," or go to View -> Match Frame -> Source File.

Notice that the master clip for the Timeline clip is now highlighted in the
Browser.
(Important note: For version 4.1.x of FCP, this keyboard shortcut is
listed as Shift-Command-F, which doesn't work. Command-Option-f
does.)
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Technique: Using Replace Edit
A Replace Edit is a very powerful technique, which is often useful when
locating clips using Match Frame, Let's continue where we left off with
the Match Frame technique and show you how a Replace Edit works.

1. Position your playhead at the beginning of a clip you want to replace.

2. Hold the control key down and click on the clip your playhead is in.
The third line of the pop-up menu that appears indicated the duration of
the timeline clip.
3. The key to a successful Replace Edit is to NOT have any in's or out's
set, either in the Timeline or the Viewer. Type "Option-x" to remove the
In and the Out from the Timeline.

4. Open the new clip you want to use to replace the existing Timeline
clip into the Viewer. Position the playhead at the point you want the new
clip to start and make sure the duration of the clip from the playhead to
the end of the clip is at least as long as the clip you are replacing in the
Timeline. (If it isn't, Final Cut won't make the edit.)

5. Drag the clip from the Viewer to the Overlay window in the Canvas
and select, "Replace edit." Final Cut will replace the clip on the Timeline
with the clip on the Viewer AND will put the frame under the playhead in
the Viewer exactly under the playhead in the Timeline.
Easy. Simple. Clean.
BUT, what makes the Replace edit even more useful is that you DON'T
need to put the playhead at the beginning of a clip. Let's say you wanted

to replace a wide shot with a close-up of, say, a car racing down a street
and crashing into a building. Plus, you want the moment of the impact to
sync with all the sound effects you've added to the sound track.
In this case, you want to match the middle of one shot (the wide shot of
the crash) with the middle of another shot (the close-up of the crash)
and make sure the new shot stays in sync with the existing audio.
Here's how to do it.
1. Load the new clip into the Browser and position the playhead at the
precise instant the car touches the building.

2. Go to the patch panel in the Timeline and disconnect the two audio
connections. This means that only the video will be added from the
Viewer, not the audio.
3. Find the clip you want to replace in the Timeline and position the
playhead over the exact frame where the car touches the building.
4. Now, drag the clip in the Viewer to the Canvas Overlay and select,
"Replace Edit."
Again, Final Cut matches the frame under the playhead in the Viewer
with the frame under the Playhead in the Timeline and switches out the
old shot for the new shot.
Another use of this technique is to add audio to a shot that was initially
edited as video only.
1. To do this, find the clip in the Timeline that you wanted to add audio.
Position the playhead over any frame in the clip and type, "Option-x" to
remove any In or Out from the Timeline.
2. Match Frame to load the clip into the Viewer. Type, "Option-x" to
remove any In or Out from the Viewer.

3. Disconnect the video in the Timeline patch panel by clicking on the
left-hand V1 tab once, so that it separates from the right side of the
patch panel.
4. Make sure the audio is patched to the correct tracks, in this case, A1
and A2 in the Viewer are patched to A3 and A4 in the Timeline. Click to
make sure the left and right sides are touching.
5. Drag the clip from the Viewer to the Overlay window in the Canvas
and select, "Replace Edit."

6. Or, click the blue button at the lower left corner of the Canvas
window. Or, press the F11 key.
A fast, simple and reliable way to replace audio, or video, on the
Timeline. And, remember, don't use any in's or out's.

Final Cut Pro Support Options Updated
If you are looking for support on Final Cut Pro, I've recently updated the
options available to you.
In addition to on-site training and support to keep your systems running
smoothly, I now provide:

●
●
●

Telephone support
Email support
Remote computer support

Click here for more information -- or call: (818) 879-5105.
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Reader Feedback - Creating Favorite Filters
Philip Hodgetts wrote in to clarify my tip last month on using dragging to
create a favorite effect.
You might want to remind your readers that when you create
a Filter Stack, it's important to *not* open the folder if you
want to use all the stack. (Your example was just the
opposite - where you want to use one item.) When you open
the folder for the filter stack, FCP will re-order the filters into
alphabetical order, not the applied order. This can, as you
know, often change the result.
Of course, if you only want to excise one filter from the stack,
opening the folder is fair game.
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Client report: Auto-saving
I got a panicked call from a client a few weeks ago. They had been
working on a project all day and saving regularly. However, at the end of
the day, they discovered they had, by accident, deleted the last twenty
minutes of their program, so that the project they had been saving was
now no good.
When they went to the Auto-save vault to pull up an earlier version,
there were no versions of their project in the Vault, even though they
had Auto-Save Vault turned on and properly set.
What was the problem?
The answer is that in Final Cut version 4.1.x, Auto-Save resets it's timer
every time you save your file using Command-S. For instance, if you set
Auto-Save to save every fifteen minutes, and you save using CommandS every five minutes, Auto-Save will never kick in -- because there was
never a fifteen minute period where you didn't save.
In talking with engineers at Apple recently about FCP HD, they told me
that one of the features they fixed was the Auto-Save bug. Now, in
version 4.5, Auto-save will save on the time schedule you specify in
preferences, regardless of whether you save your file using Command-S,
or not.
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TIP: Striping tapes
Recently, a student made a remark in class that started me thinking. I
was talking about the importance of striping tapes and he remarked that
Panasonic was recommending that if you shoot HD, you no longer stripe
tapes because "it damaged the lubrication."
First, some background. "Striping tapes" means to record audio and
video black on a tape, along with timecode and other control pulses
(This process is also called, "black and code," in Final Cut."
In the old days of linear video editing, you needed to stripe your master
tapes before editing because the edit system needed timecode on a tape
in order to control it.
Now, the big benefit to striping a tape is that it lays a continuous
timecode sequence on the tape, which means that you never have to
worry about timecode breaks when you are editing to a striped tape.
In fact, I make it a practice to always stripe new DV tapes as soon as I
buy them. That way regardless of how I shoot my tapes in the field, I
am guaranteed clean, continuous time code for my edits. This is because
DV cameras automatically match the new recording to the time code on
the tape when the record button is pressed. However, if there is no time
code on the tape, the camera restarts it at 00:00:00;00 at the moment
recording starts. It's this restarting of time code, with a lower number
following a higher number, that is as the root of the time code problems
we face when trying to capture video using FCP.
Up until my student's comment, I have always recommended striping as
a way to prevent problems recording in the field, along with simplifying
the editing process later.
So, during the recent NAB (U.S. National Association of Broadcasters)
convention in Las Vegas, I dropped into the Panasonic booth and spoke
to the head of their U.S. tape manufacturing operation to learn the facts.
He (I'm embarrassed to admit I forget to get his business card)
recommends striping tapes as well. While all modern video tapes are
lubricated to make them slide more smoothly over the tape heads, there
is nothing in the lubrication that prevents them from being striped. Just
the opposite. Striping not only lays down clean timecode, it also
stretches and tensions the tape evenly from end-to-end, which helps it
play through the camera more consistently.
Finally, striping tapes is good practice, he says, for all video formats -DV, SD and HD.
And I like striping, because it means I never have to capture across a
timecode break again.
[Update 5/17 ] Tom Wolsky wrote in to say that, in general, striping

camera tapes is not required when you are shooting SD or HD video due
to the way professional cameras record timecode to the tape. Also,
many professional shooters adjust the hour setting for timecode to
reflect the tape number (i.e. hour one for tape one, hour two for tape
two).
I agree with his points. Striping tapes is VERY helpful in a DV
environment, and general practice in all areas of post-production, but
not necessary for SD or HD camera tapes.
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First Look: The New View Menu in FCP HD
While there weren't a lot of interface changes in Final Cut HD, there
were a few. Several preference menus have expanded, as well as the
View menu. Let's take a quick look at the new options in the View menu,
some of which used to be in Preferences, to see how they can help us.

The first menu choice hasn't changed from FCP 4.1. The key to
remember is that if you want to view your DV video on an external
monitor, be sure that External Video -> All Frames is turned ON.

The Refresh A/V Devices now has its own menu and keystroke, which
allows you to quickly have FCP connect to a camera or deck that you just
connected or turned on. This tells the program to look for any newly
connected devices.

Video Playback moved from the A/V Preferences menu to the View
menu. This allows you to select the external device and format to view
your video.

Audio Playback also moved from the A/V Preferences menu to the View
menu. This allows you to specify where you'll be monitoring audio. To
avoid lip sync issues, the best choice is "Audio Follows Video."
Go to Top.

Article Update: Copy/Paste Changes, Again!
With the release of FCP HD, Apple has again changed how copy and
paste work for clips on the timeline.
For those of you keeping track on your scorecards...
●
●

●

FCP 4.0. Copy/paste followed the settings in the patch panel
FCP 4.1: Copy/paste followed the settings of the Auto-Select
buttons
FCP 4.5: Paste now pastes a clip to the same track from which it
was copied, UNLESS after you copy it, you change an Auto-Select
button.

Lisa Brenneis recently sent me the following description, which explains
it perfectly:
FCP Protocol: Auto-Select in FCP HD

When you paste cut or copied clips into a sequence, the clips
will be pasted into the same tracks you cut them from unless
you make a change to the Auto Select controls after you cut
(or copy) but before you paste. If you do, then the Auto
Select controls determine the track destination of pasted
tracks. Tracks will be pasted starting at the lowest-numbered
Auto Select?enabled track.
Audio and video paste destinations are tracked separately i.
e., if you enable a video Auto Select control between cutting
and pasting but leave the audio Auto Select controls
untouched, the video portion will be pasted according to your
Auto Select setting, but the audio portion will be pasted into
the same tracks you cut them from.

Lisa compiled a complete explanation of EVERY possible Auto-Select
setting -- so I've revised the Auto-Select article. Click here to learn the
details.
By the way, I am a big fan of Lisa and her "Visual Quick Start Guides to
Final Cut Pro" books. Her latest edition, for FCP HD, will be available
from PeachPit Press in July.
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Reader Feedback - Choosing a Codec
The article on how to choose a codec drew a lot of responses. Two of
these are from vendors and one from an editor.
Mike Stroven - Aurora Video Systems

I enjoyed your article on LAFCPUG, but I did take note of
your statement that the BetaSP and BetaSX environments
are somehow limited to 8-bit resolution internally. I was
wondering what source you had for this little tidbit, since I
myself have been seeing more and more claims about the
"limitations" of these tried and true analog formats.
This claim has been perpetrated upon us by people in high
places at companies who claim to know about video, but the
"BetaSP is limited internally to 8-bit" statement that those
people make just doesn't stand up to scrutiny. The main
point of contention is with the manufacturer's published
Signal to Noise specifications. An 8-bit linear Digital to Analog
converter (D-to-A) can represent 256 discreet levels per
channel. A 1 in 256 sample of Noise represents a signal to
noise ratio of ~46dB. The Sony documentation for the
PVW2800 BetaSP deck lists 53 dB S/N when using metal
tape. So, who is wrong? I believe that the TBC in the output
stage of a good Betacam deck is digital, but it is definitely not
limited to 8 bit linear resolution. If is is limited to 8-bits, the
processing *must* be logarithmic in order to maintain the
published S/N spec. If it *is* logarithmic, then it is certainly
NOT the same as the 8-bit LINEAR A/D and D/A resolution of
most video capture cards (our IgniterX series included).
That said, I was also wondering if you've ever compared an
Aurora 8-bit codec to a Pinnacle, AJA, or Apple 10-bit codec
side by side, let alone an Aurora 10-bit codec against any
codec on the planet? Might be worth some research.) We
have a new "Pipe" family now shipping which shatters price
barriers for true 10-bit cards.
Marco Solario of One River Media http://www.onerivermedia.
com has done extensive testing of Auroras codecs, and has
posted results and techniques to reproduce these tests on his
website. They are an interesting read.

[Larry responds] The reason I did not mention the Aurora series of cards
was that I have not had an opportunity to work with one.
--Charles Cloutman

I just read your article [on codecs] and noticed that you left
out the most affordable and reliable (I might add) card, the
Decklink. We used to use Pinnacle but had continued
problems as well as having to be married to their codec. We
tried to switch to AJA I/O but in comparison with the
Blackmagic Decklink the Decklink walked away because of its
low cost. We are currently using Decklink SP with video from
Beta SP written on an internal media drive. We live capture
60 minutes of uncompressed 8 bit (Apple's) with 2 channels
of audio on a G5 dual 2Gb. We then bring in another 2
channels of audio, lots of graphics, video insert shots. We
build a weekly 30 minute program for broadcast on 11 tv
stations - All without problem.
So long to the days of proprietary codecs and expensive and
finicky storage arrays. We have to keep our media drive
purged to keep seek times in control but its working fine.
--Shane Betts - Blackmagic Design

We released our new 4:4:4 Dual Link Decklink HD Pro card at
NAB last week. We have the cards in manufacture right now
and we are currently in the final stages of cleaning up the
software for release. Consequently we hope to begin shipping
the cards within a month.
At that stage we will supplement both our Decklink drivers
and our free codecs package with our new 4:4:4 codecs. Our
current packages contain our uncompressed 4:2:2 HD codecs
as well as our SD codecs.
At this stage I believe our image size for editing in Final Cut
Pro HD will be 1920 x 1080 to enable real-time editing and
pixel-for-pixel display via dual link to our HDLink and on to
the 23" Cinema Display. The card also has 14 bit RGB
outputs so the images on a CRT are awesome!
There has been a feature film completed recently in Australia
capturing direct from datacine to HDD via our single link card
and, by eliminating the compression inherent in going to
tape, the pictures on 35mm look extremely good - more like
you'd expect from 2K. A local software developer has a
solution for allowing Final Cut Pro to drive the datacine as if it
were a deck, so conforming worked exactly like a batch
capture. Very cool and the whole process took less than 30
hours! Also, there are a number of developers already
working on methodologies and workflows to allow our cards
to capture to larger files and work with proxies so the next

six months or so may see the whole DI process go the way
Final Cut Pro has taken NLE. Very exciting.

Article: Color-Correcting Using the Limit Effect
The 3-way Color Correction filter has a tremendous amount of power.
This article explores a little-known function, the Limit Effect, to show you
how you can achieve some truly exotic color effects with it.
Click to read article: Color-Correcting Using the Limit Effect.

Here's the commercial that supports this newsletter.
I provide system design, consulting, editing, training and support for
Final Cut Pro and DVD Studio Pro.
If you need help, I'd appreciate it if you would give me a call, (818) 8795105, or send me an email -- larry@larryjordan.biz.
My client list speaks for itself.
Thanks.
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Wrap-up
Well, that's it for this edition of the newsletter. Let me know what you
think, and tell your friends to subscribe. Also, please send me your
comments, along with suggestions for future stories. (I'll even take
editor jokes!)
Planned for next month (and, yes, this changes up until the last minute as long-time subscribers have noticed):
●
●
●
●
●
●
●

Power tips for better color correction
How to stripe tapes with black and time-code
Using the Pen tool to quickly create smoother moves and effects
Continuing our look into FCP HD
Another "Client Report"
Reader feedback
And more as I think of it...

Thanks -- and have fun editing!
Larry

Legal Notes
The newsletter is free -- but does require a subscription. Please invite your
friends to sign up at www.larryjordan.biz.
To unsubscribe, simply send me an email and I'll drop you from the list. This
list is not sold, rented, or bartered. The only person who knows you are on this
list is me.
The information in this newsletter is believed to be accurate at the time of
publication. However, due to the variety of possible system and software
configurations, the author assumes no liability in case things go wrong. Please
use your best judgment in applying these ideas.
The opinions expressed in these newsletters are solely those of the author.
This newsletter has not been reviewed or sanctioned by Apple, or any other
third party. All trademarks are the property of their respective owners and are
mentioned here for editorial purposes only.
Text copyright 2004 by Larry Jordan. All rights reserved. This may not be
reproduced, in any way, in whole or in part, without written permission from
the author.
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